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Home Network Checklist
Follow these steps to enjoy the Home Media Features of your TiVo DVR.

Connect Your DVR(s) to Your Home Network. Choose Wireless using the 
TiVo USB Wireless Network Adapter (pictured here, available from 
www.tivo.com/store), or Wired (Ethernet) using the DVR’s built-in 
Ethernet jack. See the Start Here poster that came with your TiVo 
DVR, or visit www.tivo.com/network for setup help.

Name Your DVRs. Naming your DVRs will help you identify them 
when using the TiVoToGo feature, Online Scheduling, and Multi-
Room Viewing. To name your DVRs, log in to Manage My Account at 
www.tivo.com/manage, and choose DVR Preferences from the left 
hand menu.

Set Your DVR Preferences. Using Manage My Account, specify which 
DVRs in your home network are allowed to transfer programs with 
other DVRs (Multi-Room Viewing) and with your computer (the 
TiVoToGoTM feature). Click DVR Preferences in the left column, then 
check Allow Transfers and Enable Video Downloads.

Install TiVo Desktop. Download and install the free TiVo Desktop 
application to a computer connected to your home network. Just go to 
www.tivo.com/desktop. Be sure to check the TiVo Desktop system 
requirements before downloading and installing. For full functionality, 
purchase the upgrade to TiVo Desktop Plus.

Link to Your TiVo Account. Link your PC to your TiVo service account 
by entering your e-mail address and password (the same used to log in 
to Manage My Account).

Enter Your Media Access Key. When you install TiVo Desktop, be sure 
to enter your Media Access Key. Your Media Access Key keeps your 
TiVo recordings secure, and prevents them from being played or 
transferred outside your home network.

You can find your Media Access Key on any DVR connected to your 
home network. From TiVo Central, select Messages & Settings, then 
Account & System Information, then Media Access Key. You can also 
find your Media Access Key at www.tivo.com/manage.

Enable Home Network Applications. TiVo has partnered with a variety 
of media companies to bring you exciting new home entertainment 
opportunities. You can find them all collected under Music, Photos, 
Products, & More, right on TiVo Central.

Select Enable Home Network Applications at the bottom of the list, 
then press THUMBS UP three times, then ENTER.

Ready to go? Then continue with The Basics in Five Short Tours, on page 3.

The TiVo Wireless USB Network Adapter

Name Your DVRs

You can choose any name for your DVR, 

up to 16 characters. It might be helpful to associate 

a DVR’s name with its location in your home. For 

example, you might name the DVR in your living 

room “Living Room.”

®
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Tour One: Transferring Programs within 
Your Home Network
When your TiVo DVR is connected to your home network, it’s easy to 
transfer recorded programs to a PC or any other TiVo DVR connected to the 
same home network.

Transferring Programs to Your PC with TiVoToGoTM

Watch your favorite shows on your PC or laptop using a compatible media 
player. Here’s how:

� On your PC, launch TiVo Desktop.

� Click the button Pick Recordings to Transfer.

� A window showing your TiVo DVR’s Now Playing List appears.

If you have more than one TiVo DVR in your home network, their 
names appear in a pull-down list. Select the DVR that has the recording 
you want to transfer. After a few seconds, the selected DVR’s Now 
Playing List appears.

� Highlight any title in the list to see more information about the 
program—the same program information you have on your TiVo DVR.

� Check the box next to the title of the program (or programs) you want to 
transfer.

� Click the button Start Transfer.

That’s it! While transferring recordings, TiVo Desktop displays the status 
and the time remaining. Click the Transfer Status button to view details of 
transfers in progress. Transfer times vary, but may take as long as the 
program’s duration (i.e., up to one hour for a one hour program).

Setting Up Auto-Transfers

If the program is part of a series, you’ll see the button Auto-Transfer this 
Series. Click this button, and TiVo Desktop will transfer each episode 
automatically as soon as it’s finished recording on your DVR.

Watching Recordings on Your PC

Recordings you transfer to your computer are listed in TiVo Desktop’s Now 
Playing List.

To watch a recording, select any title from the list (even one that’s still 
transferring) and click Play. Your computer’s default media player (in most 
cases, Windows Media Player) starts automatically.

Refer to your media player’s instructions for more about playing recordings.

Before You Begin

Make sure you make all the necessary 

settings in your TiVo service account, on your PC, 

and on your DVR. See the Home Network Checklist 

on page 2.

Programs that cannot be transferred due 

to copy protection restrictions are 

marked with a red circle slash.
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Transferring Programs Between DVRs 
(Multi-Room Viewing)
When you have more than one DVR connected to your home network, you 
can easily transfer programs between them. Here’s how it works:

� Go to the DVR that you want to transfer programs to. For this example, 
let’s call it the Bedroom DVR.

� At the bottom of the Bedroom DVR’s Now Playing List, highlight the 
DVR you want to transfer programs from. Let’s call this the Living 
Room DVR.

DVRs in your home network are marked on the 
Now Playing List by the DVR icon.

Press SELECT to see the Living Room DVR’s 
Now Playing List.

� Find the program you want to transfer from the Living Room DVR to 
the Bedroom DVR. Highlight it and press SELECT.

� Select Watch on this TV. On the Getting Program screen, you can choose 
to watch the program as it is transferring, or continue browsing the 
Living Room DVR’s Now Playing List. 

If you watch the program as it is transferring, you might experience 
intermittent delays in the transfer, depending on your network speed.

Once the program is transferred from the Living Room DVR to the 
Bedroom DVR, the recording exists in both locations. If you delete the 
program from one DVR, you can still find it on the other.

Transferring From a Paused Location

Let’s say you’ve watched the first half of a movie in one room, and want to 
finish it in another. You don’t need to transfer the whole movie; transfer 
only the part you have not watched.

� From the receiving DVR’s Now Playing List, select the sending DVR.

� Press SELECT on the program you want to transfer, then select Watch 
from the paused location. 

Please note, the program cannot be playing on the sending DVR when 
you start the transfer.

Stopping a Transfer in Progress

To stop a transfer in progress, select the program title from the Now Playing 
on the receiving DVR, then select Stop transferring.

If you choose Stop transfer & delete from Now Playing, the portion of the 
program that has already transferred to the receiving DVR is deleted. The 
program remains intact on the sending DVR.

Name Your DVRs

Giving your DVRs unique names helps to 

identify them when transferring programs. Name 

your DVRs using Manage My Account at 

www.tivo.com/manage.

By default, a DVR’s name is the last four characters 

of its TiVo service number.

®

Multiple Transfers

A TiVo DVR can only send one program 

at a time. It can also only receive one program at a 

time. If you choose to transfer more than one 

program, it completes the first transfer before 

starting on the next. A DVR may both send and 

receive a program at the same time, but doing so 

will probably reduce the speed of both transfers.
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Tour Two: Moving Recordings to a 
Portable Player
TiVo Desktop can automatically prepare each transferred TiVo recording 
for use with a portable video player, either by adding the recording to your 
media library or converting to your player’s preferred video format.

Recordings transferred to TiVo Desktop’s Now Playing List need to be 
converted to a format that your portable device can read. You can set this to 
happen automatically, or you can convert individual recordings.

Converting a Recording for a Portable Player
If your portable media player is Windows-compatible, your TiVo recordings 
need no conversion. If you have another kind of portable player, follow 
these steps:

� Upgrade to TiVo Desktop Plus (see side note).

� Highlight a recording in TiVo Desktop’s Now Playing List.

� Right-mouse click and select Convert for..., then select your device. 
Converted recordings appear in the default folder:

\My Documents\My TiVo Recordings for Portables

Setting Up Automatic Conversions
To set TiVo Desktop to convert recordings for your portable device:

� Choose Preferences from the File menu.

� Click the Portable Devices tab.

� Choose an option under Libraries & Formats.

• Add to my Windows Media Library (for Windows Portable Media 
Players).

• Convert to a portable media device format. After you upgrade to 
TiVo Desktop Plus, additional conversion formats are available. 
Choose your device from the list.

� If you want TiVo Desktop to delete the original recording from the “My 
TiVo recordings” folder after the conversion for your portable device is 
complete, check the box “Delete the original transferred files after 
conversion.” This avoids storing multiple copies of the same recording 
on your computer.

� Once you’ve made this setting, recordings transferred to your TiVo 
Desktop Now Playing List will be converted for your portable device 
automatically. Converted recordings appear in the folder:

\My Documents\My TiVo Recordings for Portables

TiVo Recordings on a Creative Zen player.

Upgrade to TiVo Desktop Plus

TiVo Desktop includes compatibility with 

Microsoft Windows-based portable media players.

Upgrade to TiVo Desktop Plus for compatibility with 

additional media players, including the Sony PSP, 

Nokia N80, Palm Treo 650, and other H.264 

compatible devices such as the Apple iPod. TiVo 

Desktop Plus also allows for compatibility with 

MPEG-4 compatible devices.

To upgrade, just choose “Upgrade to TiVo Desktop 

Plus” from the Help menu in TiVo Desktop.

Add to Media Library

Set your Preferences (from the File menu) 

for portable devices, and files are added to your 

Windows Media Library or iTunes library 

automatically. TiVo Desktop Plus is required for 

Apple iPod support.

®
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Moving Recordings to Your Portable Device
Browse to the folder \My Documents\My TiVo Recordings for Portables. In 
most cases, you can simply drag and drop converted recordings to the 
portable media player connected to your computer.

Windows Media Library. No conversion is required for TiVo recordings to 
play on your Windows Portable Media Center. TiVo recordings appear 
automatically in the media library in Windows Media Player 10. 

Special Instructions for the Sony PSPTM

After TiVo recordings are converted for the PSP, you’ll find the files in a 
folder called “My TiVo Recordings for Portables” inside the 
“MyDocuments” folder. 

If your PSP is running system software version 2.8 or later, copy the files to 
the PSP’s \Video folder, and you’re done.

If your PSP is running system software earlier than 2.8, follow these steps:

� Connect your PSP to your computer via USB using a USB A to mini b 
cable.

� Turn on your PSP. Choose Settings, then USB Connection, and press 
the X button. The PSP should appear as a drive under My Computer.

� Find the converted recordings in \My Documents\My TiVo Recordings 
for Portables\Sony PSP. The files will be named with the title of the 
program and the record date.

� Copy the converted recordings to the PSP drive, into the directory 
called \MP_ROOT\100MNV01. If this directory doesn’t exist, create it.

� After the files are copied to the \MP_ROOT\100MNV01 directory on the 
PSP, they must be renamed using a specific naming style so that the 
PSP can read them. To do this:

• Right-mouse click on the first file and select Rename.

• Rename the file M4Vxxxxx.MP4 but instead of the five x’s, use a 
unique five-digit number.

• Repeat for each file.

Once each file is renamed according to this naming style, it is ready to 
play on your PSP.

Consult your portable media player’s 

documentation for help importing video files.
®

Sony Memory Stick

The Sony PSP is not compatible with all 

memory stick media. For additional instructions and 

troubleshooting visit memorystick.com/psp.

You will need a USB A to mini b cable to 

connect your PSP to your computer. Also, 

make sure your memory stick is 

formatted for your PSP before you begin.
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Tour Three: Downloading TV, Movies & 
Web Video
When your TiVo DVR is connected to the Internet via your home network, 
you have access to a variety of new sources of programming.

Amazon Unbox on TiVo
When you link your TiVo® service account to your Amazon 1-Click® 
purchasing account, you’re able to buy or rent videos and have them 
downloaded automatically to your TiVo DVR.

Linking Your Accounts

� On your PC, sign in to your TiVo service account at tivo.com/manage.

Click DVR Preferences on the left side, and make sure your TiVo 
DVRs are checked to enable video downloads.

� Sign in to your amazon.com account. Confirm it is set up for 1-Click® 
purchasing.

� Browse to amazon.com/tivo and click the Amazon Unbox on TiVo link.

� Click the button Register Now. Follow the instructions to link your 
Amazon and TiVo accounts.

� Once the process is complete, return to browsing Unbox videos.

Finding and Downloading Unbox Videos

On your TiVo DVR, just select Find Programs, then Download TV, Movies 
& Web Video, then Amazon Unbox. Or from any web browser:

� Browse Amazon Unbox video downloads at amazon.com/unbox.

� When you find a video to buy or rent, click on it.

� On the right side, look for a button like this one: 

The drop-down list shows all TiVo DVRs linked 
to your account.

� Select the DVR you want to download to, and 
click the Rent Now or Buy Now button.

The video will appear on your DVR’s Now Playing List when the download 
is complete. Rented videos are available for 30 days, and playable for 24 
hours after you first press PLAY. Purchased videos are marked Keep Until I 
Delete on your Now Playing List.

Read the Terms of Use linked below the download button for more 
information about rented and purchased videos.

Browse Unbox from Your DVR

Once your accounts are linked, find and 

download movies right from your sofa! From TiVo 

Central select Find Programs, then Download TV, 

Movies & Web Video, then Amazon Unbox.

®
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YouTube on TiVo
Now you can browse and view YouTube videos from the comfort of your 
couch with your broadband-connected TiVo HD or Series3 DVR. 
WARNING: YouTube on TiVo is unbelievably easy to use and can be 
joyously addictive.

Finding videos to watch

Browsing YouTube on TiVo is just as easy as browsing YouTube on the 
Internet. Here's how:

� Go to TiVo Central and select Find Programs and Downloads, then 
Download Movies, TV and Web Video, then YouTube. Here you'll see 
familiar video categories as well as an option to Search.

• When you highlight Featured Videos or Most Recent, you'll see a 
list of videos on the right. Use the arrow buttons on your remote to 
browse the list. Use CHAN/PAGE to page up and down.

• When you highlight Top Favorites, Most Viewed, or Top Rated, 
you'll see options to limit the list to videos uploaded today, this 
week, in the past 30 days, or all time. Select a time period to see a 
list of videos.

• Select Search to enter a search 
term. Once you type a few 
letters, a list of videos appears.

� When you find a video you want to 
watch, highlight it and press PLAY.

Playing YouTube videos on your TiVo DVR

Playing YouTube videos on TiVo is just like playing a TiVo recording. You 
can pause, rewind, fast-forward, and instant replay just as you would with 
any other video on your TiVo DVR. However, there are some unique 
features of YouTube videos:

• To stop playing a video and return to the list, press the LEFT arrow.

• When the video ends, you can replay it by pressing 
INSTANT REPLAY.

• When playback finishes, you'll see a list of related or similar videos. Use 
the arrow buttons to move up and down through the list, and press PLAY 
to play a video.

• YouTube videos are not stored on your DVR, so they do not appear on 
the Now Playing List and they do not use any available recording space.

TiVo HD and Series3 HD DVRs

YouTube on TiVo is only available on TiVo 

HD and TiVo Series3 HD DVRs.

YouTube Search Tips

To search for similar words, use the 

asterisk (*) as a wild card character that replaces 

the endings of words. For example, enter AIRP* to 

find 'airplane,' 'airport,' 'airplay,' and 'airpark.'

For search terms of more than one word, enter a 

space by selecting 'SPC' or pressing the FORWARD 

button on your TiVo remote.

®

YouTube and TiVo KidZone

YouTube videos may contain content not 

suitable for all viewers. You may restrict access to 

this feature by enabling the TiVo DVR's built-in 

KidZone™ feature.

®
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Web Video Downloads
With TiVo Desktop Plus, you can download videos in a variety of video 
formats from your PC, or from the Internet,  to your DVR. Enjoy your 
digital home movies, favorite web videos, and podcasts on your TiVo DVR!

Supported Video Formats

Supported video formats include:

• Windows Media Video (.wmv)

• QuickTime Movie (.mov)

• MPEG-4 / H.264 (.mp4, .m4v, .mp4v)

• MPEG-2 (.mpg, .mpeg, .mpe, .mp2, .mp2v, .mpv2)

• DivX or Xvid (.avi, .divx)

Videos protected with DRM or other copy protection are not supported. 
Video files containing more than one audio track are not supported.

Find and Download Web Videos on your DVR

Your broadband-connected TiVo DVR gives you access to a wide variety of 
web videos. Browse and download web videos just as youwould broadcast 
TV programs. You can even set up Season PassTM recordings to your 
favorite web videos so you’ll never miss a “webisode.”

To download web videos:

� From TiVo Central, select Find Programs, then Download TV, Movies, 
& Web Video.

� Select Browse Other Videos.

� Look for videos to download by category.

� When you find something you like, you can choose to download an 
episode, or get a Season Pass.

Some web videos require that your PC is turned on and running TiVo 
Desktop Plus. These videos are marked on the list with a PC icon.

Downloaded videos appear on your Now Playing List just like any other 
recorded program.

Upgrade to TiVo Desktop Plus

To upgrade, just choose “Upgrade to TiVo 

Desktop Plus” from the Help menu in TiVo Desktop.

®

Videos marked with a PC icon appear when 

your PC is on and running TiVo Desktop Plus.

A double checkmark indicates you have a 

Season Pass for this video download.
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Adding Video Folders

Videos in the My TiVo Recordings folder (inside the My Documents folder 
on your PC) are always available for transfer to your DVR. Just select your 
PC from the DVR’s Now Playing List and select a video to transfer.

If you have video files or podcasts that automatically download to different 
folders on your PC, you can also add those video folders.

To add a folder of videos:

� Open TiVo Desktop and select the Share Music, Photos, & Videos icon.

� Click the Video tab, then click the Add Video button.

� Navigate to the folder containing the folder of video 
you want to add. Select the folder and click the Add button. 

� Set your Video Folder Properties, including:

• Whether to auto-transfer videos from this folder to your DVR

• How many videos from this folder to keep on the DVR

• Which DVR(s) will get videos from this folder

� Click OK when finished.

If you’ve set your video folder to auto-transfer, videos saved to that folder 
will appear on your DVR’s Now Playing List when the transfer is complete.

Transferring Video from Your PC to Your DVR

If you have set your video folders to auto-transfer videos, you can just look 
for your published video folders on your DVR’s Now Playing List.

You can also transfer videos in your My TiVo Recordings folder individually:

� Select your PC from the DVR’s Now Playing List. It is marked with the 
computer icon: 

� Highlight any title in the list and press SELECT. Choose Watch on this 
TV to start the transfer.

When the transfer starts, you have the option of watching the video 
immediately, or choosing additional videos to transfer.

Some things to keep in mind:

You may not be able to transfer or play back some video content. This could 
be due to many factors, including:

• The content is protected. Videos that are protected with DRM are not 
supported.

• The file transfer failed. If the transfer fails, try rebooting your computer 
and attempting the transfer again.

• The file may be in an incompatible format for playback.

VPN Issues

TiVo Desktop and your TiVo DVRs may 

not be able to communicate while using a Virtual 

Private Network (VPN) connection.

Select your PC to view the list of videos in 

your My TiVo Recordings folder

Web Video Quality

Web video content will appear in the 

same quality as the original downloaded content. 

The DVR will not improve the video quality or 

screen resolution of downloaded content.
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Tour Four: Find Something New with 
Swivel SearchTM

Swivel Search lets you explore the vast universe of entertainment in a whole 
new way. It finds programming from both broadcast TV and broadband 
sources, like Amazon Unbox downloads.

You can find Swivel Search under Find Programs, or by selecting More 
Options from any recorded program.

How does Swivel Search work?
Swivel Search helps you find new programs related to programs you already 
like using tags. Tags are topic-related terms that might not be in the 
program’s title or description, but are assigned to programs that fall under 
similar subjects of interest. When you find a program using Swivel Search, 
shared tags can lead you to related programming, and opportunities to record 
or download. 

Here’s an example: 

� Using Swivel Search, enter NEW YORK. Use the keypad to enter 
letters; the FORWARD button on the remote enters a space. 

� Notice that the tag NEW YORK appears in the right column marked 
with the TiVo Tag icon: .

� Highlight the NEW YORK tag and press SELECT. A screen listing a 
wide variety of matching programs appears, everything from Law & 
Order, to Sesame Street, to General Hospital. 

� Highlight Law & Order, press the RIGHT arrow to move to “More 
info...” in the right column, and press SELECT. The Law & Order 
series screen allows you to browse Upcoming Showings, and gives you 
a list of actors and tags in the left column. 

� Highlight the actor name 
S. Epatha Merkerson, and 
you’ll see TV shows and 
movies in which she appears, 
including any movies available 
for download marked by the 
download icon: .

A Swivel Search using the 
NEW YORK tag can lead you 
to the movie Lackawanna Blues, starring S. Epatha Merkerson, set in 
upstate New York. That’s just one example of how Swivel Search leads 
you down interesting paths to discover and record programming with 
your TiVo DVR.

Opt-In for Best Results

Swivel Search works best if it searches 

only on channels you receive, ensuring that search 

results always include programs you can record. To 

do this, Swivel Search prompts you to change your 

privacy status to “opt in,” allowing the TiVo service 

to store information about your channel lineup for 

use in Swivel Search.

To start a new Swivel Search, press the 

INSTANT REPLAY button on 

your TiVo remote.
®
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If You Like This
When you view a program screen using Swivel Search, you have an 
opportunity to find similar programs by highlighting “If You Like This...” 
Titles of related programs appear in the right column.

Actors and tags listed in the left column also lead you to related 
programming. And each title you find can lead you to more related 
programs. You may discover something new, find something you've 
forgotten about, or surprise yourself along the way with random television 
trivia. Click by click, you'll see how your favorite shows, actors, and topics 
are all connected. And of course, at any time, you can easily schedule TiVo 
recordings.

Swivel Search Options
From the main Swivel Search screen, press ENTER to view Swivel Search 
Options. Use this to change the list of channels that Swivel Search uses to 
find programs. You can search on the Channels You Receive (channels you 
have marked with a check on your DVR’s Channel List), or switch to All 
channels in your lineup.

Remember, if you switch to All Channels, Swivel Search might display 
programs on channels you don’t subscribe to, and can’t record.
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Tour Five: Music & Photos
Music & Photos lets you use your TiVo DVR to play music or display 
photos stored on your home computer. 

Publishing Music & Photos with TiVo Desktop
TiVo Desktop stores shortcuts to digital music and photo files on your 
computer. It also saves information about how you want those files 
displayed on your DVR.

File Formats

Music File Formats. TiVo Desktop works with music in the MP3 format. 

Music Playlist Formats. TiVo Desktop works with playlists in the following 
formats used by common PC music players:

M3U, PLS, ASX, and B4S

Photo File Formats. TiVo Desktop works with photos in these formats:

BMP, TIFF, DIB, GIF, JPG, and PNG

Publishing Your Music

Publishing your music means making MP3 files available over your home 
network to your TiVo DVR. Publishing does not copy music files to your 
DVR, so published music does not use any of your DVR’s recording space.

To publish a playlist or folder of music:

� Open TiVo Desktop and select the Share Music, Photos, & Videos icon.

� Click the Music tab, then click the Add Music button.

� Navigate to the folder containing the playlist or folder of music you 
want to publish.When you select a folder, any MP3 files within that 
folder are listed in the right frame of the Add Music window. 

� To publish a whole folder of music, select the folder and click the Add 
button. To publish individual MP3 files, select them from the list on the 
right, then click the Add button.

Publishing Your Photos

Publishing your photos works just like publishing your music. Publishing 
photos means making digital image files available over your home network 
to your TiVo DVR. Publishing does not copy image files to your DVR, so it 
does not use any of your DVR’s recording space. 

To publish a folder of photos:

� Open TiVo Desktop and select the Share Music, Photos, & Videos icon.

� Click the Photos tab, then click the Add Photos button.
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� Navigate to the folder containing the photos you want to publish. When 
you select a folder, any publishable image files within that folder are 
listed in the right frame of the Add Photos window. 

� To publish a whole folder of photos, select the folder and click the Add 
button. To publish individual photos, select them from the list on the 
right, then click the Add button.

Playing Music on Your DVR
To listen to music on the TiVo DVR:

� From TiVo Central, select Music, Photos, Products & More.

� Select your music on your computer. (Your selection may vary 
depending on how your computer is named.)

� You will see any playlists or folders that you have published. Highlight 
one and press PLAY. In a few seconds, music starts playing. After the 
first song ends, the second song in the playlist or folder begins.

Changing Music Play Options

The Music Play Options screen lets you choose how music plays on your 
TiVo DVR. To get to the Music Play Options screen:

� From TiVo Central, select Music, Photos, Products & More.

� Select a music option.

� Highlight a song and press SELECT.

� Highlight Play, then Options, and press SELECT.

The Music Play Options screen lets you change the following options:

Shuffle. When shuffle is on, the DVR plays songs in the selected playlist or 
folder in random order. When this option is off, the DVR plays songs in a 
folder alphabetically by file name, and songs in a playlist in the order shown 
on the screen.

Repeat. When repeat is on, the DVR plays songs in the selected playlist or 
folder repeatedly. You can choose to repeat all songs, or just one. When this 
option is turned off, the DVR plays the entire playlist or folder only once.

Include Subfolders. When this option is on, the DVR plays:

• All the songs in the selected folder.

• All the songs in other playlists or folders inside the selected folder.

When Include Subfolders is turned off, the DVR does not automatically play 
songs in other playlists or folders within the selected folder.

Unpublishing Music or Photos

Unpublishing media files means that 

those files will not be accessible from DVRs 

connected to your home network. Unpublishing 

does not delete files from your computer.

To unpublish media files, select the files you want 

to unpublish and click the Remove button.
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Viewing Photos on Your DVR
To view photos on the TiVo Series2 DVR:

� From TiVo Central, select Music, Photos, Products & More.

� On the Music & Photos screen, you should see an option that lets you 
view the photos on your computer. For example, if your computer name 
is “My Computer” and your username is “Jill,” the option is called 
“Jill’s Photos on My Computer.” If your computer is not named, the 
option is called simply “Jill’s Photos.” Select this option.

� You will see any folders that you have published. Highlight one and 
press PLAY. In a moment you see a slide show of photos from the 
folder. Photos display in the slide show in alphabetical order by file 
name.

Changing Slide Show Options

The Slide Show Options screen lets you choose how photos display on your 
TiVo Series2 DVR. To get to the Slide Show Options screen:

� From TiVo Central, select Music, Photos, Products & More.

� Select your photos on your computer. (Your selection may vary 
depending on how your computer is named.)

� Highlight a photo or folder and press SELECT.

� Highlight Play Slide Show, then Options, and press SELECT.

The Slide Show Options screen lets you change the following options:

Slide Delay. This option determines the time to display each photo before 
going to the next.

Shuffle. This option displays the contents of the selected folder in random 
order. When this option is turned off, the DVR plays the folder’s photos 
alphabetically by file name, as shown in the grid on the screen.

Repeat. This option displays the contents of the selected folder repeatedly. 
When this option is turned off, the DVR displays the folder’s photos only 
once.

Rotating a Photo

To rotate a photo, highlight it and press 

SELECT to view it. Then select either 90 degrees 

clockwise or counterclockwise.

®
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Photos 2.0
With Photos 2.0 you will be able to dramatically enhance the clarity of your 
digital photos when viewing them using a TiVo® Series3TM HD DVR. 
Photos 2.0 displays photos in higher resolution on HD televisions and 
automatically scales JPEG images to fit in 1280 x 720 format.

To enable Photos 2.0:

� Select TiVo Server Properties from the Server menu in TiVo Desktop.

� On the Configuration tab, click the box to Preview Photos 2.0.

� On your Series3 HD DVR, you'll notice both the original Photos 
interface, as well as the new Photos 2.0, which will be marked with a 
computer icon.

Viewing Photos 2.0 on Your DVR

Browsing your digital photos on the DVR works the same as before.

� From TiVo Central, select Music, Photos, Products & More.

� On the Music & Photos screen, you should see two options that let you 
view the photos on your computer. If your computer name is “My 
Computer” and your username is “Jill,” the options are called “Jill’s 
Photos on My Computer.” If your computer is not named, the options 
are called simply “Jill’s Photos.” 

� One of these options is marked with the computer icon:  This is the 
Photos 2.0 application. Select this option.

� You will see any folders that you have published. Highlight one and 
press PLAY. In a moment you see a slide show of photos from the 
folder. Photos display in the slide show in alphabetical order by file 
name.

Do I need to install any software to use Photos 2.0?

You will need to download Java Runtime environment 1.5.0_06 or higher in 
order to utilize Photos 2.0. As Photos 2.0 is a Java application, the Java 
Loading screen will appear each time TiVo Desktop 2.0 is launched. 

You may check the version installed on your machine by going to 
http://java.com/en/download/installed.jsp and clicking Verify Installation.

Photos 2.0

The Flickr Folder

If your home network includes a 

broadband Internet connection, you will also see 

the Flickr.com folder. The Flickr.com folder is a 

free sampling of some of the most popular 

photos from their website.

®

Changing Folder Options

To change how photos in the folder are 

sorted, by name or by date, press ENTER.

®
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More Cool Things You Can Do
With a network-connected TiVo DVR, there’s almost no end to the cool 
things you can do with your TV.

Home Movie Sharing
If you enjoy making home movies of your kids, vacations, and hobbies, you 
can now share the footage with family and friends across the country on 
their TV. Home Movie Sharing gives you a private channel for family and 
friends to share photos, and videos on their TV set.

TiVo has teamed-up with One True Media, an online service that helps 
people create video montages or home movies. It is the fastest way of 
uploading your film content, and turning it into polished pieces of art done 
Hollywood style. Sign up today at onetruemedia.com/tivo, or go to TiVo 
Central and select Music, Photos, Products, & More, then Home Movies by 
One True Media.

Music Videos from Music Choice
Download music videos by popular artists from Music Choice® using your 
broadband-connected TiVo DVR. Each week new videos are added, so you 
always get the hottest stars and the latest sounds.

� Go to 'TiVo Central' > 'Find Programs' > 'Download TV & Movies' > 
'Music Choice'.

� Browse videos by genre, or search for an artist name or song title. 

� When you find a video you want to download, select it, then select 
Request This Video.

Downloaded videos appear with all of your other recorded programs, in your 
Now Playing List. You can pause and rewind downloaded music videos just 
like any other recording on your Now Playing List. Plus, you can save music 
videos as long as you like.
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Online Scheduling
Browse TV listings and schedule recordings on yoiur home DVR using 
TiVo Central Online. To start searching, sign in at tivo.com/tco.

Use the Search TV box at the top of the page to look for program titles, actor 
names, director names, or keywords. You can narrow your search to specific 
categories using the drop-down menu.

Advanced Search

For a more detailed search of TV Listings, click the Advanced Search link to 
the right of Search TV.”

Advanced Search works just like Search TV, but adds the ability to specify a 
category, a subcategory, and a choice of time periods.

Tell a Friend

When displaying your search results, TiVo Central Online offers you the 
option of telling a friend about the program(s) you found. Just click the Tell 
a Friend About This Search link on the right-hand side.

When you provide a friend’s e-mail address, TiVo Central Online will send 
details about your program search (for a specific episode, or a keyword or 
actor search) along with a personal message from you. 

The e-mail message your friend receives includes a link back to TiVo 
Central Online so your friend can schedule a recording of the same program, 
or browse the same search results. Your friend’s e-mail address will be used 
only to send this message and not for any other purpose.

More Than Music & Photos
TiVo has partnered with a variety of media companies to bring you exciting 
new home entertainment opportunities. You can find them all collected 
under Music, Photos, Products, & More, right on TiVo Central.

Be sure to Enable Home Network Applications, a selection at the bottom of 
the list. This allows your TiVo DVR to access a variety of specially-
designed applications inside and outside your home network (broadband 
Internet connection required). Home Network Applications are indicated by 
a computer icon: 

Select Enable Home Network Applications, then press THUMBS UP three 
times, then ENTER.

Do More with Your TiVo DVR

Learn more about all the cool things you can do with a broadband-connected 
TiVo DVR at tivo.com/domore.

If you publish Web content on your own site, 

you can use the unique URLs displayed 

under Link to this to link your readers to 

their own TiVo Central Online search results, 

customized for their channel lineups.

®
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